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บทนํา 
ปจจุบัน เว็บไซตนับเปนเครื่องมือที่สําคัญสําหรับการสื่อสารทั้งภายในและภายนอกองคกร ดังนั้น 

กระบวนการออกแบบเว็บไซตจึงไดกลายมาเปนกระบวนการเพื่อการสื่อสาร มากกวากระบวนการทางดาน

เทคนิค (Geest 2001) การออกแบบเว็บไซตตองมีการศึกษา วิเคราะหและตัดสินใจในประเด็นตาง ๆ 

มากมาย ทั้งการเลือกใชสี การจัดการขอมูลและการออกแบบระบบนําทาง (navigation) การแบงสวนพื้นที่

การใชงานของหนาจอ การสรางคุณลักษณะพิเศษ (character) ใหกับเว็บไซต เพื่อใหสามารถสื่อสารกับ

กลุมเปาหมายที่จะเขามาเยี่ยมชมเว็บไซต และสามารถบรรลุวัตถุประสงคของการพัฒนาเว็บไซต               

บทความนี้ นําเสนอขั้นตอนการออกแบบ การวิเคราะหเนื้อหา วัตถุประสงค และขั้นตอนการพัฒนาเว็บไซต

สถาบันการศึกษา โดยใชประสบการณในการพัฒนาเว็บไซตคณะอักษรศาสตร จุฬาลงกรณมหาวิทยาลัย 

ของผูเขียนเปนกรณีศึกษา  

 

การออกแบบเว็บไซต 
การออกแบบเว็บไซตที่ดี คือ การออกแบบใหเหมาะสมกับกลุมเปาหมายและลักษณะของเว็บไซต 

โดยคํานึงถึงความสะดวกในการใชงานของผูใชเปนหลัก เว็บไซตที่ออกแบบอยางมีประสิทธิภาพ ควรมี

ความเรียบงาย มีความสม่ําเสมอ สะทอนเอกลักษณและลักษณะขององคกรนั้นได มีเนื้อหาที่มีประโยชน           

มีระบบนําทางที่ใชงานงาย นาสนใจและดึงดูดใจ มีตราสัญลักษณ (logo) และชื่อเว็บไซตทุกหนา เขาถึง

ขอมูลโดยไมตองใชเมนูที่ซับซอน สามารถเขาถึงขอมูลที่ตองการไดทันทีโดยผูใชไมตองติดตั้งโปรแกรม

เพิ่มเติม หรือตองใชเบราวเซอรพิเศษอื่น ๆ  สามารถแสดงผลในหนาจอที่มีความละเอียดตาง ๆ กันได               

มีคุณภาพในการออกแบบ  ไมมีพื้นหลัง (background) ที่ลายตา เลือกสีพื้นหลังและสีชุดแบบอักษร (font)

อยางเหมาะสม ขนาดตัวอักษรพอเหมาะ รองรับเว็บไซตที่อาจมีขอมูลเพิ่มขึ้นเรื่อย ๆ จุดเชื่อมโยงตางๆ 

(links) สามารถเชื่อมโยงไปยังเว็บเพจที่มีอยูจริง  ปราศจากจุดเชื่อมโยงซึ่งไมทํางาน (broken link)  ใชเวลา

                                                 
* อาจารยประจําภาควิชาบรรณารักษศาสตร คณะอักษรศาสตร จุฬาลงกรณมหาวิทยาลัย 
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ในการดาวนโหลดนอย แสดงผลเร็ว และมีการปรับปรุงเนื้อหาบนเว็บไซตอยางสม่ําเสมอ (ธวัชชัย ศรีสุเทพ 

2544: 14-23; Kentie 2002; ดวงพร เกี๋ยงคํา และวงศประชา จันทรสมวงศ 2546: 26-43; Sklar 2003) 

 

กระบวนการพัฒนาเว็บไซต 
 กระบวนการในการพัฒนาเว็บไซต แบงออกไดเปน 5 ข้ันตอนที่สําคัญ ไดแก การสํารวจความ

ตองการ  การพิจารณาเนื้อหาของเว็บไซต  การกําหนดโครงสรางเว็บไซต  การออกแบบภาพ และการอนุวัต

และดําเนินการ โดยมีรายละเอียดดังนี้ (Geest 2001; ธวัชชัย ศรีสุเทพ 2544; ดวงพร เกี๋ยงคํา และ                 

วงศประชา จันทรสมวงศ 2546) 
 

ขั้นตอนที่ 1 : การสํารวจความตองการ 
 เร่ิมตนจากการศึกษาหนวยงานเจาของเว็บไซต เพื่อกําหนดเปาหมายของเว็บไซตที่ชัดเจน ศึกษา

ผูใช เพื่อใหสามารถระบุกลุมผูใช และความตองการของผูใช และศึกษาคูแขง เพื่อกําหนดกลยุทธใน               

การแขงขัน 
 

ขั้นตอนที่ 2 : การพิจารณาเนื้อหาของเว็บไซต 
 หลังจากการศึกษาขอมูลเบื้องตนและกําหนดวัตถุประสงคของเว็บไซตแลว จะสามารถกําหนด

แนวทางในการออกแบบเว็บไซต ขอบเขตเนื้อหาและการใชงาน เพื่อรวบรวมขอมูลและเนื้อหาของเว็บไซต

ตอไป 
 

ขั้นตอนที่ 3 : การกําหนดโครงสรางเวบ็ไซต 
 ในขั้นตอนนี้ จะนําขอมูลที่รวบรวมไดมาจัดระบบขอมูล โดยจัดทําแผนผังโครงสรางขอมูล และ

ออกแบบระบบนําทาง เพื่อออกแบบการใชขอมูลและเปนแนวทางในการคนดูเว็บที่จะพัฒนา 
 

ขั้นตอนที่ 4 : การออกแบบภาพ 
 ในขั้นตอนนี้ จะทําการออกแบบลักษณะหนาตาของเว็บเพจตามหลักการออกแบบเว็บที่ดี มีการ

จัดแบงพื้นที่ในหนาเว็บเพจ และมีรูปแบบโครงสรางขอมูลอยูในหนาเว็บที่ออกแบบนี้ ผลลัพธในขั้นตอนนี้

คือ เว็บเพจตนแบบที่จะใชพัฒนาเปนเว็บไซตตอไป 
 

ขั้นตอนที่ 5 : การอนวุัตและดําเนนิการ  
 ในขั้นตอนนี้ เปนการนําเว็บเพจที่ออกแบบมาสรางเปนเว็บไซตที่สมบูรณ รวมถึงการอัปโหลด 

เว็บไซตสูเครื่องแมขายเพื่อเผยแพรบนอินเทอรเน็ต และกําหนดแนวทางการบํารุงรักษาเว็บไซตทั้งเนื้อหา

และโครงสรางขอมูลใหทันสมัยอยูเสมอ 
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 สําหรับการออกแบบเว็บเพจตนแบบ มักจะใชโปรแกรมกราฟก เชน  Adobe Photoshop ในการ

ออกแบบ เนื่องจากสามารถเคลื่อนยายชิ้นสวนสวนตาง ๆ ของเว็บเพจ ทั้งภาพและสวนของพื้นที่ใชงาน             

แตละสวนไดโดยสะดวก อีกทั้งยังสามารถสรางภาพและตกแตงภาพประกอบเว็บเพจในหนาตนแบบไดเลย

โดยไมตองกังวลกับการจัดหนาในเอกสารดวยภาษาเอชทีเอ็มแอล ซึ่งตองอาศัยเทคนิคการจัดพื้นที่สวน

ตางๆดวยตารางที่ซับซอน สําหรับข้ันตอนในการพัฒนาเว็บเพจที่ออกแบบดวย Adobe Photoshop เปน 

เว็บเพจ มักจะใชโปรแกรมชวยสรางเว็บ เชน Macromedia Dreamweaver  Microsoft FrontPage  Allaire 

HomeSite เปนตน (ธวัชชัย ศรีสุเทพ 2544; ดวงพร เกี๋ยงคํา และวงศประชา จันทรสมวงศ 2546; ฐิตารัตน 

รัชตะวรรณ 2547) 

 

การพัฒนาเว็บไซตคณะอักษรศาสตร จุฬาลงกรณมหาวิทยาลัย 
 จากการที่ผูเขียนไดมีสวนในการออกแบบและพัฒนาเว็บไซตคณะอักษรศาสตร จุฬาลงกรณ

มหาวิทยาลัย จึงขอนําประสบการณจากการออกแบบและพัฒนาเว็บไซตดังกลาวมาเปนกรณีศึกษา 

ตลอดจนนํามาใชเปนตัวอยางประกอบการอธิบายตามทฤษฎี/หลักการออกแบบและพัฒนาเว็บไซตที่ได

นําเสนอไปในหัวขอที่ผานมา  โดยเริ่มตั้งแตการสํารวจความตองการ  การพิจารณาเนื้อหาของเว็บไซต             

การกําหนดโครงสรางเว็บไซต  การออกแบบภาพ และการอนุวัตและดําเนินการ จนเปนเว็บไซตที่สมบูรณ 
 

ขั้นตอนที่ 1 : การสํารวจความตองการ   
การสรางเว็บไซตสถาบันการศึกษาที่สามารถดึงดูดกลุมผูใชเปาหมายได จําเปนที่จะตองทําการ

วิเคราะหขอมูลเกี่ยวกับองคกรและผูใช  กําหนดวัตถุประสงคของเว็บไซต และศึกษาเว็บไซตของ

สถาบันการศึกษาอื่นที่มีลักษณะเดียวกัน  เพื่อทําใหเกิดความเขาใจองคกร และนําไปสูการออกแบบไดตรง

กับกลุมเปาหมาย และระบุคุณลักษณะของเว็บไซตได  
 

การวิเคราะหขอมูลเกี่ยวกับองคกรและผูใช 

ผูเขียนไดทําการวิเคราะหปณิธาน พันธกิจ และวัตถุประสงคของคณะอักษรศาสตรจากคูมือ

คุณภาพ   คณะอักษรศาสตร จุฬาลงกรณมหาวิทยาลัย (2547: 10, 19) ซึ่งทําใหสามารถประมวลภาพรวม

ของคณะตามปณิธาน  พันธกิจและวัตถุประสงคที่วางไว ดังนี้ 

• ผลิตบัณฑิต ระดับปริญญาตรี-โท-เอก  กอใหเกิดขอมูลหลักสูตร เอกสารประกอบการสอน ทั้ง

หลักสูตรภาคปกติ และหลกัสูตรนานาชาต ิตลอดจนการสนับสนนุกิจกรรมตาง ๆ ของนิสิต 

• ผลิตผลงานวชิาการ กอใหเกิดตํารา/บทความ/งานวิจัย 

• บริการวิชาการ กอใหเกิดโครงการอบรมตาง ๆ ทัง้สําหรบับุคลากร และบุคคลภายนอก 

• กิจกรรมทาํนบุํารุงศิลปวัฒนธรรมไทย-สากล กอใหเกดิกิจกรรม โครงการตาง ๆ 
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จากการวิเคราะหปณิธาน พันธกิจ และวัตถุประสงคของคณะอักษรศาสตร ทําใหพอที่จะประเมิน

ลักษณะกลุมผูใชเปาหมายซึ่งคาดวาจะเปนผูใชเว็บไซตคณะอักษรศาสตรไดดังนี้ 

• นักเรียนชัน้มัธยมศึกษาตอนปลาย  

• นิสิตระดับปริญญาตรี ปริญญาโท ปริญญาเอก ทัง้นิสิตไทยและนิสิตตางชาติที่สนใจหลักสูตร

นานาชาต ิ

• นักวชิาการ นกัวิจัย บุคคลในวงวิชาการทัง้ในและตางประเทศ  

• บุคคลภายนอกที่สนใจการอบรมหลักสูตรทางดานอักษรศาสตร 
• บุคคลทั่วไป รวมถงึผูปกครอง 
 

เมื่อวิเคราะหกลุมผูใชเปาหมายไดแลว ตอไปจะเปนการกาํหนดวัตถุประสงคของเวบ็ไซต 

 

กําหนดวัตถปุระสงคของเวบ็ไซต 

จากกลุมผูใชเปาหมายขางตน ผูเขียนไดกําหนดวัตถปุระสงคของเวบ็ไซต ดังนี ้

เว็บไซตคณะอักษรศาสตร จุฬาฯ จัดทําขึ้นเพื่อใหบริการขอมูลเกี่ยวกับคณะ หลักสูตรที่เปดสอน และ

บริการวิชาการ กิจกรรมตาง ๆ ที่คณะจัด รวมถึงแสดงผลงานวิชาการที่จัดทําโดยคณาจารยในคณะ และเพื่อ

ชวยในการเผยแพรผลงานวิชาการ โดยใหบริการขอมูลแกนักเรียน นิสิต-นักศึกษา นักวิชาการ นักวิจัยและ

บุคคลในวงวิชาการ รวมถึงบุคคลภายนอก และผูปกครอง 

 

การศึกษาเว็บไซตสถาบันการศึกษาทีม่ีลักษณะเดียวกัน 

 การศึกษาเว็บไซตที่มีลักษณะการดําเนินงานใกลเคียงกัน จะชวยใหไดแนวคิดในการออกแบบ   

ชวยในการเลือกสี การจัดวางขอมูล และการแบงพื้นที่ใชงาน  ในเดือนพฤษภาคม 2548 ผูเขียนได

ทําการศึกษาเว็บไซตจากโฮมเพจและเว็บเพจของมหาวิทยาลัยชั้นนําในตางประเทศที่เปดสอนในหลักสูตร

อักษรศาสตรจํานวน 5 แหง แลวนํามาวิเคราะหเกี่ยวกับการออกแบบ การเลือกสี การจัดวางขอมูล และ 

การแบงพื้นที่ใชงาน  โดยมีรายละเอียดดังนี้ 
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Harvard University, Faculty of Arts and Science  (http://www.harvard.edu)  

 
โฮมเพจ       เว็บเพจ 

ใชโทนสีเขียว-แดง (สีตรงขามกัน*) มีโฮมเพจที่โดดเดน แตระบบนําทางมีการเปลี่ยนรูปแบบเมื่อเขาสูเมนู          

ใด ๆ ในโฮมเพจ ทําใหใชงานยาก 

 

Cornell University  (http://www.cornell.edu) 

 
โฮมเพจ          เว็บเพจ 

ใชโทนสีแดง – เทา (เขาไดกับทุกสี) มีโฮมเพจที่โดดเดน และระบบนําทางเหมือนเดิมในทุกๆหนา ทําให              

ใชงานงาย 

 

 

 

 

 

                                                 
* ดูทฤษฎีสีเพิ่มเติมในหัวขอ การพิจารณาเนื้อหาของเว็บไซต : การเลือกใชสี หนา 60 
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Monash University, Faculty of Arts  (http://www.arts.monash.edu.au) 

 
โฮมเพจ          เว็บเพจ 
 

ใชโทนสีแดง – ฟาเขม (สีตรงขามใกลเคยีง) เนนความเปนมนุษยศาสตรดวยการแสดงภาพคน มสีวนบริการ 
และสามารถคนหาขอมูลในเว็บไซตได  ระบบนําทางและสวนบรกิารเหมือนกันทุกหนา ใชงานงาย 
 

 

The University of British Columbia, Faculty of Arts  (http://www.arts.ubc.ca) 

 
โฮมเพจ          เว็บเพจ 
 

ใชโทนสีน้ําเงิน – น้ําตาลแดง (สีตรงขามใกลเคียง) เนนความเปนมนุษยศาสตรดวยการแสดงละคร และ

สถาปตยกรรม  แมวาในโฮมเพจและเว็บเพจจะยายตําแหนงของระบบนําทาง แตรูปแบบและวิธีใชคงเดิม 

เสริมสรางใหหนาแรกดูโดดเดน  
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he University of Ontario, Faculty of Arts and Humanities  (http://www.uwo.ca/arts) T

 
โฮมเพจ          เว็บเพจ 

ปะ 

ผูเขียนไดใชขอมูลจากการศึกษาเว็บไซตที่มีลักษณะเดียวกันกับคณะอักษรศาสตร จุฬาฯ เปนแนวทาง

นการก

ั้นตอนที่ 2 : การพิจารณาเนื้อหาของเว็บไซต 
ระสงคของเว็บไซต และศึกษาเว็บไซตจากตางประเทศ

ลว  ข้ัน

รูปแบบและเอกลักษณของเว็บไซต

 

ชโทนเขียว-มวง-แดง  เนนความเปนมนุษยศาสตรดวยภาพคนและศลิใ

 

 

ใ ําหนดรูปแบบของเว็บไซตตอไป 

 
ข
 เมื่อไดสํารวจขอมูลเบื้องตน กําหนดวัตถุป

แ ตอนตอไปจะเปนการพิจารณาถึงรูปแบบและเอกลักษณของเว็บไซต การเลือกใชสี การออกแบบ

การใชงาน และการกําหนดขอบเขตของเนื้อหาสําหรับเว็บไซตคณะอักษรศาสตร จุฬาฯ ซึ่งจะไดนําเสนอ

ตามลําดับตอไปนี้ 
 

การกําหนด  

ความตองการของกลุมผูใชเปาหมาย ดังนั้น ในการ

กําหนด

รี รูปแบบเว็บไซตนารัก สดใส 

ุขุม เปนทางการ 

  

การออกแบบเว็บไซตที่ดีควรออกแบบใหตรงกับ

แนวทางในการพัฒนาเว็บไซต จะตองกําหนดรูปแบบของเว็บไซตที่ตองการ กลุมเปาหมายของ

เว็บไซตอาจจําแนกตามระดับการศึกษา ความสนใจ อายุ เปนตน ทั้งนี้ปจจัยที่ใชประกอบการพิจารณา

จําแนกกลุมผูใชอาจสงผลตอรูปแบบของเว็บไซตได เชน 
 

ลุมผูใชเปาหมาย แบงตามระดับการศึกษา ก

o นักเรียนมัธยมปลาย – นิสิตปริญญาต

o นิสิตระดับปริญญาโท - เอก – นักวิจัย/วิชาการ รูปแบบเว็บไซตที่ส
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กลุมเปาหมาย แบงตามความสนใจ 

ูมิศาสตร วัฒนธรรม ภูมิปญญา 

วันตก  
 

ระ น ไรจึงจะสามารถใหเว็บไซตที่

ออกแบ

าง

o วรรณคดี ละคร  
o ประวัติศาสตร – ภ

o ศิลปะ หรือการสรางสรรคอารยธรรมตะวันออก - ตะ

ป เด็ ทาทายประเด็นหนึ่งในการออกแบบเว็บไซต คือ ทําอยาง

บ สามารถรองรับผูใชไดหลายกลุม (Geest 2001) จากการวิเคราะหขางตน จะเห็นไดวา              

คณะอักษรศาสตร มีกลุมผูใชเปาหมายที่หลากหลาย อย ไรก็ดี ไมวากลุมเปาหมายจะมีระดับการศึกษา

และอายุที่แตกตางกัน  หรือมีความสนใจขอบเขตเนื้อหาทางดานมนุษยศาสตรที่ แตกตางกัน                

กลุมเปาหมายหลักนาจะเปนผูที่มีความสนใจในสาขาดังกลาว ซึ่งสะทอนผานบุคลิกภาพที่มีความ

ละเอียดออน สุขุม ลุมลึก และมุงศึกษาความเจริญงอกงามในจิตใจมนุษย  ผูเขียนจึงเลือกที่จะสรางเว็บไซต

ที่มีความสุภาพออนโยน โดยผูเขียนเลือกใชดอกชงโคซึ่งเปนสัญลักษณหนึ่งของคณะ เพื่อสรางความ

ออนหวานและสรางเอกลักษณใหกับเว็บไซต 
 

ารเลือกใชสีก  

สีในเว็บไซต หากใชอยางสม่ําเสมอตลอดทั้งเว็บไซต จะสามารถใชเพื่อ “...สรางขอบเขตของ

เว็บไซต              

ส

ฉ

ที่สัมผัสไดดวยตา เมื่อผูใชคลิกเขาไปในแตละหนาก็ยังรูสึกไดวากําลังอยูในเว็บไซตเดียวกัน” 

(ธวัชชัย ศรีสุเทพ 2544: 206) การเลือกใช Theme สี จะชวยสรางใหเกิดความรูสึกแตกตางกันไป เชน 

Theme สีน้ําเงิน ใหความรูสึกสงบ เยือกเย็น มั่นคง Theme สีเทา ใหความรูสึกสุภาพและสรางสรรค 

Theme ีสม-เหลือง ใหความรูสึกสดใส การเลือกใชสี มีรูปแบบการใชชุดสีหลากหลาย เชน เลือกใชทุกสี 

เลือกใชเ พาะโทนสีรอน หรือโทนสีเย็น เลือกใชชุดสีตรงขามใกลเคียงกัน เลือกใชสีเดียวแตที่ระดับความ

เขม-สวางแตกตางกัน หรือเลือกใชสีเดียวในหลายเฉดสี เปนตน  (ธวัชชัย ศรีสุเทพ 2544: 183-205) 

 

 

 
เล ี หรือเฉพาะสีตรงข  งาย  ือกทุกส ามกัน      ใชเฉพาะสีโทนรอน/เย็น  วงจรสีอยาง

 

 

แดง 

อน

ฟาน้ําท
ฟา 

ม 

 

บาน

แดงเขม 

เขียวอ  

เขียวแก 

ะเล ฟาเข

น้ําเงิน

มวง 

เย็น 

 สม 

แดง 

เหลือง

 สม เหลือง 
มวง 

เขียว 

น้ําเงิน 
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              สีปกติ สวาง10% 25%  ทึบ10% 25% 

สีตรงขาม      ใชเฉพ  สีใดสีหนึ่งหลายเฉดสี 

ีของเว็บไซตมหาวิทยาลัยในตางประเทศที่เลือกศึกษา มีการใช Theme สีที่แตกตางกัน สําหรับสีที่

เลือกใช

   

ัน เนื่องจากตองการเนนใหใชงาน

งายมาก

   
ใกลเคียงกัน   าะสีใดสีหนึ่งที่ความสวาง-เขมตางกัน           ใชเฉพาะ

 

 

ส

ในเว็บไซตคณะอักษรศาสตร ผูเขียนเลือกสีขาว-เทา เนื่องจากสีเทาเปนสีสัญลักษณของคณะ           

และใหความรูสึกสุขุม มีปญญา ขณะที่สีขาว ใหความรูสึกสะอาด สําหรับพื้นหลังและชุดแบบอักษร            

ควรเลือกสีที่มีความเหมาะสมกัน (ธวัชชัย ศรีสุเทพ 2544; Kentie 2002)   ผูเขียนเลือกสีพื้นหลังสีขาวและ

ตัวอักษรสีเทาเขม เพื่อใหอานไดงาย และเขากับ Theme สีที่เลือกไว ทั้งนี้ เว็บไซตที่ดีควรหลีกเลี่ยงพื้นหลัง

ที่ลายตา (Kentie 2002) ผูเขียนจึงกําหนดพื้นหลังของเว็บไซตดวยสีพื้น 

นอกจากนี้ ผูเขียนตั้งใจจะใช Theme ในแตละเมนูเปนคนละสีก

กวาการสราง Theme สีที่เนนใหเกิดความรูสึก สําหรับโทนสี ผูเขียนเลือกใชสีที่มีความสวาง และ

เปนชุดสีในแตละเมนูดวยเหตุผลทางเทคนิค เพื่อใหโหลดสีและหนาเว็บไดรวดเร็ว  

 

   
Theme สีเดียวกันทัง้เว็บ   Theme สีแยกตามเมนู

 

ชมพูเขม

แดง 

เขียวแก 
ฟาเขม 

ชมพ

ชมพูออน

ู matt 

  

  ็นชมพูบานเย  

  ชมพูมวง ชมพูโอรส 
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การออกแบบการใชงาน 

ะแนวคิดในการออกแบบและพัฒนาเว็บไซต ผูเขียนไดนําหลักการมา

ประมวล

งาย และกาํหนดใหมีแผนที่นาํทาง 

2. นได 

ี

3. าจอคอมพวิเตอรที่มีความละเอียด (Resolution) ตางกัน เชน  

4. บ หรือวนิโดวแบบ Pop-up ที่เปดขึ้นมา

ดง

พ

5. ขนาด Default 

บ

   

6. 

 

 

สําหรับรายละเอียดเกี่ยวกับจํานวนเมน ูและเนื้อหา จะวเิคราะห จัดโครงสรางขอมูลของเว็บไซต 

และนําเ

จากการศึกษาทฤษฎีแล

และกําหนดแนวทางในการออกแบบการใชงานดังนี้  

1. ผูเขียนเลือกทีจ่ะใชสีแบงแยกตามเมนูเพื่อใหใชงานได
(Navigation Map) ในทุกหนา เพื่อใหผูใชทราบวากาํลังอยูในตําแหนงใดของเว็บไซต  

เว็บไซตคณะอักษรศาสตรทีจ่ะพัฒนา ควรมีจุดเชื่อมโยงไปยังโฮมเพจภาควิชา/หนวยงา

เนื่องจากผูใชเว็บสามารถใชจุดเชื่อมโยงดังกลาวเพื่อเขาสูเว็บไซตของภาควิชา/หนวยงานซึง่ม

หลายเว็บไดทนัทีเมื่อตองการ  

เว็บเพจที่สรางจะตองรองรับหน

800x600 จุดภาพ (pixel)  1024x768 จุดภาพ เปนตน 

หลีกเลี่ยงสิง่ทีผู่ใชอาจไมคาดหวัง เชน เสยีงเพลงประกอ

เมื่อโหลดหนาเว็บ เนื่องจากอาจทาํใหเกิดความรําคาญได (Kentie 2002) เว็บไซตคณะอักษร

ศาสตร จึงไมมีเสียงเพลง และไมแสดงขอความประชาสมัพันธใด ๆ ดวยวนิโดว Pop-up แตแส

เนื้อหาบนหนาเว็บเพจเลย หากจะแสดงขอมูลในลักษณะวินโดวแบบ Pop-up ผูเขียนจะแสดง

ขอความใหผูใชทราบ และเลอืกคลิกดูโดยสมัครใจเอง เชน คลิกดูภาพปกหนงัสือ หรือคลิกดูภา

กิจกรรมแบบขยายขนาด ซึง่การดูขอมูลเชนนีโ้ดยสวนใหญจะเปดเปนวนิโดวใหม  

ตัวอักษรควรมขีนาดพอเหมาะ (ธวชัชัย ศรีสุเทพ 2544; Kentie 2002) ผูเขียนเลือก

Font เปน Microsoft Sans Serif ขนาด 10 point ซึ่งเปนชุดแบบอักษรขนาดมาตรฐานที่ผูดูแลเว็บ

สวนใหญใช  บางคนอาจกาํหนดขนาดชุดแบบอักษรไวตายตัวเพื่อใหไมกระทบกับรูปแบบหนา

เอกสารที่จัดไว แตเพื่อใหรองรับกลุมเปาหมายที่อาจมีอายุที่แตกตางกัน ผูเขียนไดกําหนดชุดแบ

อักษรใหผูใชเว็บสามารถปรบัขนาดตัวอักษรเพิ่มเติมไดจากเมนู View > Text Size ของเบราวเซอร

ผูเขียนใหความสําคัญกับการใชงานที่เขาใจงาย   เมนู คาํสั่งการตาง ๆ  รวมถึงสวนตอประสานผูใช 

(Interface) จึงตองมีขอความที่ชัดเจนตามหลักการระบปุาย (Labeling) ดังนั้น หากมีสวนใดที่ให

ผูใชคลิกตอ หรือใหดาวนโหลดผูเขียนจะแสดงขอความบนหนาจอใหชัดเจน เชน กดเพื่อดูรูปขยาย

download .doc   download pdf   ดหูนาปก   ดูรายละเอียด เปนตน  

สนอในขั้นตอนตอไป 
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กําหนดขอบเขตของเนื้อหา 

ัตถุประสงคของเว็บไซต ผูเขียนไดรวบรวมขอมูลที่จะ

เผยแพร

จากการศึกษากลุมผูใชเปาหมายและว

บนเว็บไซต รวมถึงภาพประกอบขอมูล และภาพที่จะใชทําเว็บเพจ ซึ่งผูเขียนไดทําการถายรูปคณะ

อักษรศาสตรจุฬาฯ ในมุมที่ตองการเพิ่มเติม โดยจัดเก็บไวโฟลเดอร “ภาพถายคณะอักษรศาสตร” 

 

 
 

ั้นตอนที่ 3 : การกําหนดโครงสรางเวบ็ไซต  
รสารนิเทศในเว็บไซตคือ จะทําอยางไรที่จะชวยไมใหผูใช

ับสนก

ใ

ารของคณะ ประกอบดวย ขาวประชาสัมพันธ ประกาศสําหรับนิสิต 

ระดับที่ 2:  ขอมูลการบริหารงานคณะ ประกอบดวยเว็บเพจที่จําแนกตามฝายตาง ๆ ของคณะ 

ระดับที่ 3:  รายละเอียดปลีกยอยอื่น ๆ ภายใตงานบริหารคณะ เชน เว็บไซตของแตละภาควิชา  

 
ข
 ประเด็นสําคัญประการหนึ่งของการจัดกา

ส ับขอมูลจํานวนมากบนเว็บไซต (Geest 2001) ดังนั้น การจัดระบบใหกับโครงสรางเว็บไซตจึงมี

ความสําคัญตอการจัดการขอมูลบนเว็บ เพื่อใหผู ชสามารถเขาถึงขอมูลไดงาย ไมควรจัดโครงสรางขอมูลที่

มีระดับช้ัน (Hierarchy) จํานวนมาก การพัฒนาเว็บไซตที่ดี ควรมีการวางแผนการจัดวางขอมูลที่ชัดเจนโดย

ใชหลัก Flat Hierarchy (Sklar 2003) จากขอมูลที่วิเคราะหและรวบรวมไวในขั้นตอนที่ 1  ผูเขียนไดนํามา

จัดโครงสรางเว็บไซตจํานวน 3 ระดับ ดังนี้ 
 

 ระดับที่ 1:  การแจงขาวส 

การรับสมัครนิสิต/บุคลากร ผลงานวิชาการของคณาจารยในคณะ และแถบเมนูสําหรับคลิกไปยังสวนอื่น ๆ ของ

เว็บไซต 

  

ไดแก ฝายบริหาร ฝายวิชาการ ฝายวิรัชกิจ ฝายวิจัย และฝายกิจการนิสิต รวมถึงเว็บเพจแนะนําคณะใน

ภาพรวม 

  

ภาพถาย หนังสือในโครงการตําราคณะอักษรศาสตร ขอมูลวิจัย เปนตน 
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หนาแรก 

แนะนําคณะ บริหาร วิชาการ วิรัชกิจ วิจัย กิจการนิสิต 

จุดเชื่อมโยงไปยัง
เว็บไซตหนวยงาน 

นามานุกรม
บุคลากร 

แผนที่
เว็บไซต 

-ขอมูลเกี่ยวกับคณะ 
-ภาพถายคณะ 

-ผูบริหาร 
-นโยบาย 
-บุคลากร 

-ขอมูลหลักสูตร 
-กิจกรรมวิชาการ 

-ขอมูลความเปน 
  นานาชาติ 
-กิจกรรมวิรัชกิจ 

-ขอมูลทุนวิจัย 
-หนวยงานวิจัย 
-ผลงานทางวิชาการ
ที่จําหนาย 

-ขอมูลสําหรับนิสิต
-กิจกรรมสําหรับ 
   นิสิต 

-ขาวประชาสัมพันธ 
-ขาวสําหรับนิสิต 
-ขอมูลหลักสูตร 
-ผลงานวิชาการใหมที่ออกจําหนาย 

ระดับท่ี 3  หากมีเนื้อหามาก หรือมีภาพเปนจํานวนมาก จะแสดงเนื้อหาโดยยอ และแยก
รายละเอียดเปนแฟมขอมูลระดับที่ 3 เพื่อใหแสดงผลไดเร็ว  

ระดับท่ี 2 

 ระดับท่ี 1 

 
การแบงพืน้ทีแ่สดงขอมูลบนหนาจอและระบบนําทาง 

การออกแบบพื้นที่หนาจอ แนะนําใหทําในโปรแกรม Power Point กอน เพื่อรางและกําหนดพื้นที่

การใชงาน ซึ่งจะสามารถกําหนดการใชสีคราว ๆ ไดดวย โดยทั่วไป เว็บไซตจะประกอบดวยตราสัญลักษณ

ของเว็บไซต  ระบบนําทาง คือ เมนูหลัก เมนูยอย  และอาจมีสวนบริการซึ่งสวนมากใชการวางเมนูพิเศษ 

เชน แผนที่เว็บไซต การคนหาขอมูลภายในเว็บไซต (site search) หรือเมนูแบบกระโดด (Jump menu)     

สวนการแบงพื้นที่โดยมากจะตางกันที่รูปแบบของเมนูยอยซึ่งมีอยูดวยกัน 3 แบบ แตละแบบมีขอดี-

ขอจํากัดแตกตางกัน ดังนี้ 

แบบที่ 1  เมนูยอยที่สามารถเก็บไวโดยไมแสดงออกมาใหผูใชเห็น แตจะแสดงเมื่อนําเมาสไปวาง

บนปาย  แถบเมนูหลักจะมีเนื้อที่แสดงเนื้อหามาก แตหากตองการทราบเมนูยอยผูใชตองวางเมาสและคลิก

เพื่อหาขอมูลดวยตนเอง 

แบบที่ 2  เมนูยอยแสดงออกมาบนพื้นที่หนาจอเลย โดยปรากฏในแถบเมนูหลัก จะมีเนื้อที่แสดง

เนื้อหาไดมาก แตไมเหมาะกับเมนูหลักที่มีเมนูยอยจํานวนมากและไมคงที่  

แบบที่ 3  เมนูยอยแสดงออกมาบนพื้นที่หนาจอเลย โดยแสดงเฉพาะเนื้อหาที่สําคัญ แบบนี้จะมี

เนื้อที่ในการแสดงเนื้อหาลดลง แตแสดงโครงสรางขอมูลภายใตแตละเมนูหลักชัดเจนขึ้น โดยไมกระทบตอ

จํานวนเมนูยอยในแตละเมนูหลัก 
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    แบบที่ 1 เมนูยอยแสดงเมื่อวางเมาสบนปาย                                  แบบที่ 2  เมนูยอยอยูในแถบเมนูหลัก  

         

    แบบที่ 3 เมนูยอยเปนสวนหนึ่งภายใตเนื้อหาหลัก   

 

 

สําหรับเว็บไซตคณะอักษรศาสตร ผูเขียนเลือก

รูปแบบที่ 3 คือแสดงเมนูยอยบนหนาจอเลย เพื่อให

ชัดเจน และรองรับเมนูยอยในแตละเมนูหลัก ซึ่งอาจมี

จํานวนไมเทากัน  และยังเหมาะกับขอความในเมนูยอย ที่

อาจมีจํานวนคําแตกตางกัน ผูเขียนเลือกวางตําแหนงของ 

เมนูยอยที่ดานซายของหนาจอ เนื่องจากเปนตําแหนงที่

เว็บสวนใหญใชเปนที่อยูของจุดเชื่อมโยงตาง ๆ   Kentie (2002) ไดทําการศึกษาเว็บไซตชื่อดังของ

สหรัฐอเมริกาจํานวน 50 ไซต พบวา เว็บไซต 3 ใน 4 เลือกวางตําแหนงจุดเชื่อมโยงในบริเวณนี้ เว็บที่ผาน

การออกแบบตามมาตรฐาน จะทําใหผูใชคนดูไดงาย อีกทั้งยังทําใหรูสึกอุนใจและรูสึกคุนเคย แมวาอาจทํา

ใหเกิดความรูสึกเบื่อในบางครั้ง (ครัก 2545) 

 Menu1 >> sub-menu2 

 สําหรับตําแหนงของตราสัญลักษณ ผูเขียนออกแบบใหอยูในตําแหนงซายมือของหนาจอ เนื่องจาก

เปนแบบแผนมาตรฐานหนึ่งเชนกัน และเปนตําแหนงที่ผูใชเว็บจะดูในคร้ังแรกเมื่อเปดหนาจอตามหลัก

ทฤษฎีจากการศึกษาพฤติกรรมผูใชเว็บ 2 รูปแบบ คือ (Sklar 2003: 46-48)  

1) ทฤษฎีการกวาดสายตาแบบ Paper-based reading pattern เปนการกวาดสายตาอานในรูปแบบ

เดียวกับการอานหนังสือ คือกวาดสายตาจาก ซายไปขวา จากบนลงลาง สําหรับเว็บที่เปนลักษณะเว็บ

เนื้อหา เชนเว็บคณะอักษรศาสตรที่จะพัฒนา ผูใชเว็บจะกวาดตาเปนแนวซิกแซกดังภาพ 
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2) ทฤษฎีการกวาดสายตาแบบ Screen-based viewing pattern เปนการกวาดสายตาตามเข็มนาฬกิา 

ในเว็บที่แสดงหนาแรกเปนภาพทางเลือกในการเขาถึงขอมูลเชนเดียวกับการใชสัญรูป (icon)  

 

     

Logo 
                           Menu1 
 
 Menu 2                         Menu 3  

 
 Menu 4                          Menu 5 
 

Menu6
 

การกวาดสายตาแบบ Paper-based reading pattern    การกวาดสายตาแบบ Screen-based viewing pattern 

 

 

นอกจากนี้ ผูเขียนยังกําหนดใหมีแผนที่นําทางในทุกหนา เพื่อใหทราบตําแหนงในเว็บไซต และ         

ไมหลงทาง โดยกําหนดใหมีแผนที่เว็บไซตในสวนบริการ เพื่อคอยบริการขอมูลแกผูใชงาน  

จากการศึกษาเว็บไซตตางประเทศที่มีลักษณะเดียวกันกับเว็บไซตคณะอักษรศาสตร ผูเขียนเห็นวา

จุดเชื่อมโยงไปยังภาควิชา / หนวยงาน ที่ทําเปนเมนูแบบกระโดด ทําใหประหยัดเนื้อที่บนหนาเว็บเพจ       

ไดมาก จึงไดนํามาจัดใหอยูในสวนบริการของเว็บเพจทุกหนา เพื่อใหสามารถใชงานไดทุกเมื่อและบรรลุ            

ขอกําหนดการใชงาน    

แผนที่นําทางและขอมูลในสวนบริการ คือ แผนที่เว็บไซตสําหรับเชื่อมโยงไปยังภาควิชา/หนวยงาน 

และสารบบบุคลากร ถือเปนขอมูลสําคัญที่ควรจัดใหมีในเว็บเพจทุกหนา เปนไปตามกฎการออกแบบ

เว็บไซตที่ดีขอหนึ่งที่กําหนดใหบรรจุเนื้อหาที่มีคุณคาไวบนเว็บเพจทุกหนา (Kentie 2002: 2) 

 
ขั้นตอนที่ 4 : การออกแบบภาพ  
 จากการสํารวจขอมูลและวิเคราะหขอกําหนดเบื้องตน ผูเขียนไดนําขอกําหนดตาง ๆ มาทําการ

ออกแบบเว็บเพจดวยโปรแกรม Adobe Photoshop ซึ่งนอกจากจะชวยในการออกแบบแลว ภาพที่ไดจาก

โปรแกรมสามารถใชในการพัฒนาเว็บเพจ หรือจัดทําเปนแฟมขอมูลเอชทีเอ็มแอล ที่สามารถแสดงผลผาน

เว็บเบราวเซอรที่สมบูรณตอไป 
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 ข้ันตอนการออกแบบภาพสาํหรับเว็บเพจโดยใชโปรแกรม Adobe Photoshop มีรายละเอียดดังนี ้

1. เปดโปรแกรม Internet Explorer และปรับความละเอียดของจอเปนขนาด 800x600 จุดภาพ ซึ่ง

เปนหนาจอมาตรฐานสําหรับใชดูหนาเว็บ กดปุม Print Screen แลวสรางเอกสารใหม ขนาด 

800x600 จุดภาพ แลว Paste จะไดภาพขนาด 800x600 จุดภาพ เชนเดียวกับขนาดจอ  

2. ทําการแทรกภาพที่ตองการในหนาเอกสาร โดยใช Selection Tool เลือกสวนของภาพที่ตองการ 

แลวใช  Move Tool ลากภาพที่ตองการเขามา  

3. ใช Type Tool สรางขอความ และตราสัญลักษณตามตองการ 

 
 

4. สรางปุมโดยใช Shape Tool และ Text Tool อาจเชื่อม Text กับปุมโดยการเชื่อมโยง Layer ทัง้สอง 

แนะนาํใหสรางโฟลเดอร สําหรับเก็บ Layer ที่ใชประกอบเปนสวน ๆ เชน โฟลเดอรเมนู  โฟลเดอร

ตราสัญลักษณ เปนตน  
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ทั้งนี้ ผูเขียนไดเลือกสีในแตละเมนู โดยการเรียงลําดับสีตามวงจรสี และเลือกสีสําหรับแตละเมนู 

ตามความหมายและความรูสึกที่สีส่ือสารดังที่ธวัชชัย ศรีสุเทพ (2544: 183-205) ระบุไว เพื่อใหบรรลุ

วัตถุประสงคของการใชขอมูลในแตละเมนู ดังนี้ 

• สีชมพู เปนสีสัญลักษณของจุฬาลงกรณมหาวิทยาลัย ผูเขียนจงึเลือกเปนสีเมนูสําหรบั

โฮมเพจ และเมนูแนะนาํคณะ ซึ่งเปนสวนหนึง่ของจฬุาลงกรณมหาวทิยาลยั 

• สีมวง ใหความรูสึกสูงสง สรางสรรค มีปญญา จึงเลือกใหเปนสีของเมนู บริหาร 

• สีน้ําเงิน เปนสแีหงความมัน่คง ความฉลาดรอบรู  จึงเลอืกใหเปนสขีองเมนู วิชาการ 

• สีเขียว ใหความรูสึกยินด ีภักดี ความหวงั ความอุดมสมบรูณ จึงเลือกใหเปนสีของเมนู     

วิรัชกิจ 

• สีเหลือง ใหความรูสึกของการมองโลกในแงดี อบอุน มีธรรมะ จึงเลือกใหเปนสีของเมนู 

วิจัย 

• สีสม ใหความรูสึกกระตือรือรน เขมแข็ง อบอุน เปนมิตร จึงเลือกใหเปนสีของเมนู กจิการ

นิสิต 

5. สรางแถบประกาศ (Banner) โดยการใช Selection และ Fill สี อาจใชหลายสีซอนกันเปนหลาย 

Layer   
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6. สวนของสทีี่ตองการไลสี ใช Gradient Tool  

 
 

7. เติมขอความดวย Type Tool  

8. วางตาํแหนงของขอมูลตามตองการ  

 
 
ขั้นตอนที่ 5 : การอนวุัตและดําเนนิการ  
 เมื่อไดภาพเว็บเพจที่ตองการแลว ตอไปจะเปนการพัฒนาเว็บไซตโดยใชภาพที่ไดรับการออกแบบนี้ 

เปนหนาเว็บเพจ ซึ่งทําไดโดยการตัดภาพ และนําไปดําเนินการตอในโปรแกรมชวยสรางเว็บ ซึ่งผูเขียนใช

โปรแกรม Dreamweaver หลังจากที่ไดหนาเว็บเพจหนาแรกซึ่งเปนเว็บเพจตนแบบแลว ใหพัฒนาหนาเว็บ

หนารองตอไป ผูเขียนไดพัฒนาเว็บเพจหนารองและสรางเปนแผนแบบ (template) สําหรับใชเปนตนแบบ

ของเว็บเพจหนารอง ดังขั้นตอนการพัฒนาเว็บเพจจากไฟล Photoshop โดยสังเขปตอไปนี้ 
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1. เมื่อไดภาพเวบ็เพจที่ตองการแลว ทาํการตัดสวนภาพ โดยใช Crop Tool 

 
 

2. ลากเสน Guide เขามาจากไมบรรทัด  
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3. ใช Slice Tool ตัดภาพตามที่ทาํ Guide ไว  

 
 

 

4. เมื่อตัดภาพแลวคลิกขวาทีแ่ตละสวน เลอืก Edit Slice Options… แลวตั้งชื่อแตละสวน เพื่อนําไป

ตั้งชื่อใหกับแฟมขอมูลภาพที่จะตัดออกเปนแตละสวน  

 

1 

2 
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5. File > Save for Web คลิกที่แตละสวน แลวเลือกวาจะ Save เปนแฟมขอมูลจิฟ หรือเจเพ็ก 

สําหรับการตัดภาพในครั้งแรก แนะนําใหเลือกภาพเปนเจเพ็ก และเลือก Quality เปน 100 

เนื่องจากภาพที่ตัดแลว จะนํามาตัดภาพตออีกในภายหลัง 

 
 

6. กรณีที่ตัดภาพไว Photoshop ให Save เปนแฟมขอมูลเอชทีเอ็มแอลหนึ่งแฟม โดยแทรกภาพที่ตัด

ไวในตาราง จากกรณีนี้ จากภาพหนาเว็บเพจหนึ่งภาพ (แฟมขอมูล) เมื่อตัดภาพแลว Save for 

Web แลว จะไดแฟมขอมูลเอชทีเอ็มแอล ที่ประกอบดวยภาพ 4 ภาพ  ตั้งชื่อใหกับแฟมขอมูล

เหลานี้ แลวกดปุม Save ทั้งนี้ แนะนําให Save ไวในโฟลเดอรตางหาก โดยใหสรางโฟลเดอรใหม

สําหรับเก็บแฟมขอมูลทุกแฟม ทั้งแฟมขอมูลเอชทีเอ็มแอล และแฟมขอมูลภาพ ที่จะใชพัฒนาเปน

เว็บไซตที่สมบูรณตอไป 
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7. เขาโปรแกรม Dreamweaver ทําการ Define Site ไปที่โฟลเดอรที่สรางไว จากนั้นดับเบิลคลิกที่

แฟมขอมูลที่ Save ไว Dreamweaver จะเปดแฟมขอมูลให ดังภาพ 

8. เมื่อคลิกที่ภาพ จะเห็นวาภาพจากโปรแกรม Photoshop เพียงภาพเดียวในตอนแรก ไดกลายเปน 4 

ภาพแทรกในตาราง 1 คอลัมน 4 แถว แตละภาพมีชื่อแฟมขอมูลตามที่ตั้งชื่อไวเมื่อ Edit Slice 

Option  โดยแฟมขอมูลภาพ จะอยูในโฟลเดอร images ซึ่งเปนโฟลเดอรที่สรางดวยโปรแกรม 

Photoshop เมื่อ Save for Web เปนแฟมขอมูลเอชทีเอ็มแอล 

 

ภาพที่ 1 
ภาพที่ 2 

ภาพที่ 3 

ภาพที่ 4 

โครงสรางตาราง 

 

9. กลับมาที่โปรแกรม Photoshop เปดแฟมขอมูลภาพที่ตัดไวในครั้งแรกในโฟลเดอร images แลวทํา

การตัดภาพเชนเดิม  
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10. จากภาพในขอ 9 จะเห็นวาจํานวนชองในแตละภาพ มีจํานวนไมเทากัน หรือมีความกวางไมเทากัน 

ซึ่งตารางในเว็บเพจ จะมีลักษณะเชนเดียวกันนี้ กลาวคือ ตารางเดียวกันในหนาเว็บ จะตองมีความ

กวางของเซลลในแตละคอลัมนเทากัน หากตองการใหเซลลในแตละแถวมีความกวางไมเทากัน 

จะตองแยกออกมาเปนคนละตารางกัน และไมสามารถทําไดเหมือนกับโปรแกรม Microsoft Word 

 

      

   Word สามารถทําได 
 เว็บไมสามารถทําได 

   

 

      

   

   

ตารางที่ 1 

ตารางที่ 2 

ตารางที่ 3 

เว็บตองแยกเปนหลายตาราง 

 

11. เมื่อ Save for Web แลว Save เปนแฟมขอมูลเอชทีเอ็มแอล อีกแฟมหนึง่ 
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12. เมื่อกลับมาที่ Dreamweaver จะเห็นวาไดแฟมขอมูลเอชทีเอ็มแอลแฟมใหม  ดับเบิลคลิกเพื่อเปด

แฟมนี้ จะไดแฟมขอมูลที่มีตาราง 1 ตาราง ขนาด 2 คอลัมน 1 แถว ตามที่ตัดภาพไว ในแตละเซลล

มีภาพที่ตัดไวแลว  

 
 

13. คลิกที่บริเวณตาราง จะปรากฏเสนสีเขียวซึ่งบอกโครงสรางของตาราง กดที่เสนรอบนอก เลือก 

Select Table แลว Edit > Copy 

 
 

14. เปดไฟลแรกทีท่ําไว คลิกภาพสวนที่ตองการแทนที่ดวยตารางซึง่มีภาพที่ตัดภาพใหม แลว Edit > 

Paste 

 
 

15. จะเหน็วาที่แฟมขอมูลแรก ในเซลลที่มีภาพที่ตัดในครั้งแรก จะมีตารางภาพที่ไดจากการตัดภาพครั้ง

ที่สอง มาแทนที่ภาพใหญนัน้ 
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16. ทําเชนนี้ กับภาพทีละสวน  

 
 

17. กําหนดสีพื้นหลังของเว็บเพจดวย Page Properties จากสวน Properties หรือจาก       

เมนู Modify > Page Properties 
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18. กดปุม F12 บนแผงแปนอกัขระเพื่อ Preview ลอง Preview ในหนาจอขนาด 800x600 จุดภาพ 

และขนาด 1024x768 จุดภาพ 

 
 

 

 

 

 

 

 

 

 

19. โครงสรางตารางจากภาพ Photoshop ที่สรางมานั้น เปนการกําหนดขนาดความกวางและความสูง

ดังนั้น จะตองปรับใหสวนขอมูลขยายตามขนาดหนาจอได ดังนี้ 
   Table width 777 px 

Cell (td) width 777 pixel height 100% 

Cell (td) width 777 pixel height xx pixel 

Cell (td) width 777 pixel height xx 

Cell (td) width 777 pixel height xx 

Table 

Height 

100% 

ตารางใหญ ใหกําหนดความกวาง 777  

        ความสูง 100% 

 

เซลลทั่วไปใหกําหนดขนาดความสูงไวเปน 

จุดภาพโดยดูจากขนาดภาพในเซลล 

 

 

เซลลที่ตองการใหขยายขนาดเมื่อขยาย

หนาจอ ใหกําหนดความสูงเปน 100% 
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20. ปรับขนาดตาราง ดงัขอกําหนดในขอ 19 ไดโดย กดที ่Tag Inspector ที่ Tag Table หลัง Tag 

Body แลวกาํหนดความสงูเปน 100 % 

 
 

21. ที่เซลลแตละเซลลอาจคลิกที่ใด ๆ กอน แลว Select Table จากนัน้ไปที่ Tag Inspector จะเหน็วา 

Select Tag Table ไวอยู ใหไปเลือก Tag td (เซลล) กําหนดขนาดความสูงของ td ใหเทากับขนาด 

ความสงูของตารางในเซลล 

 

 1 Select Table 

2  ดูขนาด ความสูง 

3  คลิก <td> 

4  เติมขนาดใหเทากัน 
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22. ที่ตารางในเซลลสวนที่ตองการใหขยายขนาดเมื่อหนาจอใหญข้ึน ใหปรับขนาดตารางเปน 100 % 

 
 

23. กําหนดใหเซลล (td) ของตารางใหญทุกเซลลในแนวตัง้เปน Top ทุกเซลลเพื่อใหขอมลูอยูชิดขอบ

บนของเซลล 
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24. กดปุม F12 เพือ่ Preview   

 
 

25. เมื่อไดผลเปนที่นาพอใจแลว พยายามตัดภาพในสวนเนือ้หา ใหเหลือภาพขนาดเล็กที่สุด ใชภาพ

นอยที่สุด โดยนําภาพมาตัดอีกเชนเดิมใน Photoshop เพื่อสรางโครงสรางตารางสาํหรับใสเนื้อหา

ของเว็บไซตดวย  
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26. จะเห็นวาผูเขียนตัดภาพออกจนหมด เหลือไวแตสวนภาพดอกไม ซึ่งใชเปนเหมือนจุดนํา (Bullet) 

หนาหัวขอ สวนชื่อหัวขอนั้น ผูเขียนใชขอความพิมพเขาไปใหม ทั้งนี้ นอกจากจะเปนการลดการใช

ภาพประกอบเว็บเพจอันจะมีผลตอเวลาที่ใชในการโหลดหนานั้น ๆ แลว ยังทําใหสามารถเพิ่มเติม 

ปรับขอความไดในทันทีใน Dreamweaver โดยมิตองกลับไปแกไขภาพหัวขอในโปรแกรม 

Photoshop  

 

27. สรางเมนูแบบกระโดด ดวย From > Jump menu 

พิมพขอความเขาไปใหมใน 
Dreamweaver 

ภาพที่ใช 

Jump 

 
 

28. ที่ปุมภาพ แทรกจุดเชื่อมโยงโดยตั้งชื่อแฟมขอมูลที่จะใชโยงไปรอไว โดยจะสรางแฟมขอมูลเหลานี้

เปนหนารองตอไป 

29. ทําการ Save  จะไดหนาแรกที่สมบูรณ ข้ันตอนตอไป คือสรางหนารอง โดยทั่วไปแลว หนาแรก 

มักจะมีความโดดเดนกวาหนารอง แตระบบนําทางที่ดีและใชงานงาย ควรมีตําแหนงในการนําทาง 

(ปุม เมนู ตางๆ) ที่อยูในตําแหนงเดียวกันทุกหนา ดังนั้น ใหทําการ Save As หนาแรกนี้ เปน

แฟมขอมูลใหมสําหรับใชเปนตนแบบสรางหนารองตอ ๆ ไป 

30. ในแฟมขอมูลใหม ทาํการตกแตง เอาแถบประกาศออก และจัดหนาสําหรับใสขอมลูในหนารอง 

แลวใชปุม Make Template สําหรับสรางแผนแบบ ใหตั้งชื่อแฟมขอมูลวา template แลว Save  
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31. สัง เกตดูชื่ อแฟมขอมูล  จะเปนการทํางานที่แฟมขอมูลชื่อ  template ซึ่ ง เปนแฟมขอมูล

นามสกุล .dwt (Dreamweaver Template) สําหรับแฟมขอมูลเอชทีเอ็มแอลของหนารองที่สรางไว 

สามารถเลือกเก็บไวทําแผนแบบอื่น ๆ หรือลบทิ้งก็ได 

การใชแผนแบบจะทําใหปรับปรุงเว็บไซตไดงาย เนื่องจากเว็บเพจหลายหนามีสวนนําทางที่

เหมือนกัน มีเพียงสวนเนื้อหาในแตละหนาเทานั้นที่แตกตางกัน ดังนั้น หากตองการปรับสวนที่

เหมือนกัน เชน เปลี่ยนภาพ เปลี่ยนชื่อไฟล ปรับเมนูยอย แลวตองแกไขทุกไฟลจึงเปนวิธีการที่ไม

เหมาะสม  ในทางกลับกันหากใชวิธีการโดยใชแผนแบบแลว การแกไขที่แฟมขอมูล template ทํา

เพียงแฟมเดียว เมื่อแกไขและ Save โปรแกรม Dreamweaver จะไปปรับแฟมขอมูลที่ใชแผนแบบ 

นั้น ๆ ใหโดยอัตโนมัติเอง 

 

 

 

 

 

 

 

 

 

 

 
 

 สวนที่มีเหมือนกันในทุกหนา (ทุกแฟมขอมูล) 
 สวนที่มีเหมือนกันในเมนูเดียวกัน 
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32. ใหทําการกําหนดสวนที่เปนพื้นที่ที่สามารถแกไขขอมูลได (สวนขอมูลที่ตางกันในแตละหนา) โดย

เนนขอมูลใหเดน (highlighting) แลวใชปุม Editable Region เมื่อสรางแผนแบบแรกแลว Save 

จากนั้น Save As แฟมขอมูล .dwt ใหมสําหรับสรางแผนแบบของเมนูใหม แลวปรับขอมูลและสีให

เปนของเมนูใหม ใหสรางแผนแบบของแตละเมนู 

 
 

33. ในการสรางไฟลจากแผนแบบ ให File > New > เลือก Tab Templates > เลือก Site และ Template 

ที่ตองการ 
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34. เมื่อไดเอกสารเอ็ชทีเอ็มแอลเปลาแลว เติมขอความ ภาพ และขอมูลอ่ืน ๆ ที่ตองการ แลว Save 

เปนแฟมขอมูลเอชทีเอ็มแอล เมื่อไดหนาเอชทีเอ็มแอลครบตามจํานวนเมนูยอยแลว ใหกลับมาที่

แฟมขอมูลแผนแบบของเมนูนั้น แลวเชื่อมตอจุดเชื่อมโยงที่เมนูยอย กับแฟมขอมูลเอชทีเอ็มแอลที่

ตองการโยงไป เมื่อทําการแกไขใด ๆ ใน template แลว Save โปรแกรมจะถามวา ตองการปรบัสวน

ที่ใชรวมกันในแฟมขอมูลที่ใชแผนแบบนี้หรือไม ใหเลือก Update 

 
 

35. กรณีที่หนาใดมีโครงสรางขอมูลที่ซ้ํา ๆ กนั ใหสรางแผนแบบที่ม ีRepeating Region  
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36. เมื่อ File > New แลวเลือกแผนแบบที่มี Repeating Region จะสามารถเพิ่ม ลบ รายการ และ           

Re-Order รายการได (เพิ่มโดยกดปุม + ลบ กดปุม – และยายรายการโดยกดปุม   ) 

 
 

37. เมื่อเชื่อมตอจุดเชื่อมโยงใหกับทุกไฟลในเว็บไซตแลว ใหทําการตรวจสอบจุดเชื่อมโยงกอนจะ

เผยแพรเว็บไซตโดยใชเมนู     Site > Check Link Site Wide โปรแกรมจะทําการตรวจสอบ

จุดเชื่อมโยงที่ปลายทางที่ยังไมมีการระบุแฟมขอมูลข้ึนมาให เพื่อคนดูชื่อแฟมที่ถูกตองใหมอีกครั้ง 
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ตัวอยางการนําเทคนิคการออกแบบเว็บเพจใหแสดงผลไดเร็วมาใชงาน 
ดวงพร เกี๋ยงคํา และวงศประชา จันทรสมวงศ (2546) ไดสรุปเทคนิคการออกแบบเว็บเพจให               

แสดงผลไดเร็วซึ่งสามารถทําไดหลายวิธี ดังนี้ 

• ลดขนาดของแฟมขอมูลเอชทีเอ็มแอล โดยตัดคําสั่ง หรือปายระบุ (tag) ที่ไมจาํเปนออกไป 

• ใชตัวอักษร และจุดเชื่อมโยงดวยภาษาเอชทีเอ็มแอล 

• ใชกราฟกใหถกูประเภท 

• ตัดแบงภาพทีม่ีขนาดใหญใหเปนภาพชิน้เล็ก ๆ 

• นํากราฟกกลบัมาใชใหมในหนาอื่น ๆ 

• กําหนดคาความกวางและความสงูของกราฟก 

• กําหนดคา Lowsrc และ Alt ของกราฟก 

• ใช Style Sheet ในการจัดรูปแบบ 

 

เว็บเพจที่ดี ควรแสดงผลหนาเว็บเพจไดรวดเร็ว ใชเวลาในการดาวนโหลดนอย (ธวัชชัย ศรีสุเทพ 

2544; ดวงพร เกี๋ยงคํา และวงศประชา จันทรสมวงศ 2546) ผูเขียนไดนําเทคนิคการออกแบบเว็บเพจให

แสดงผลไดเร็วขางตน มาใชในการพัฒนาเว็บไซตคณะอักษรศาสตร ดังนี้ 

1. การลดขนาดของแฟมขอมูลเอชทีเอ็มแอล ผูเขียนไดใชภาพประกอบใหนอยที่สุด จากการตัดภาพที่

ออกแบบดวยโปรแกรม Photoshop และพัฒนาเปนหนาเว็บเพจ ซึ่งประกอบดวยภาพขนาดใหญ 

ผูเขียนไดตัดภาพเปนชิ้นเล็กลงไปอีกหลายครั้ง และพยายามแทนที่ภาพดวยสีพื้นในตาราง               

ชื่อหัวขอในหนาแรก ผูเขียนไดแทนที่ดวยขอความ   

2. นอกจากปุมเมนูแลว จุดเชือ่มโยงอืน่ ๆ จะเปน

ขอความ ทั้งชือ่หัวขอในหนาแรก และขอความ

ของเมนูรองบนเว็บเพจที่ปรากฏในเมนูอ่ืนๆ 

3. ภาพกราฟกทีใ่ช สรางจากการ Save for Web 

ในโปรแกรม Photoshop จะเปนภาพสําหรับเว็บ 

ซึ่งจะมีขนาดเล็กกวาภาพที ่Save As เปน

แฟมขอมูลจิฟ หรือเจเพ็ก ทั่วไป 

4. การใชภาพกราฟกซ้าํ เชนภาพปุมเมน ูและภาพจุดนําของหวัขอในหนาแรก 

5. ในการแทรกภาพดวยโปรแกรม Dreamweaver โปรแกรมจะกําหนดขนาดความกวาง และความสงู

ของภาพใหโดยอัตโนมัติอยูแลว นอกจากนี้ ผูเขียนไดกาํหนด Alt text ใหกับภาพปุมเมนูอีกดวย 
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6. เว็บเพจที่จะโหลดไดเร็ว ควรมีรหัสคําสั่งใหนอยที่สุด หากตองจัดรูปแบบสีสวนใด เชน หัวขอ สีชุด

แบบอักษร สีจุดเชื่อมโยง ใหใช Style Sheet โดยเปนแฟมขอมูล Style Sheet ที่ทุกแฟม เรียกใชได

แบบเชื่อมโยง ซึ่งนอกจากจะใชรหัสคําสั่งจํานวนนอยในแตละหนาแลว ยังแกไขไดงายเนื่องจาก

แกไขจากแฟมขอมูลแฟมเดียว และทําใหเกิดความสม่ําเสมอเนื่องจากเว็บไซตใชชุดแบบอักษร

เดียวกันตลอดทั้งไซต 

 

นอกจากเทคนิคขางตนแลว ผูเขียนไดสอดแทรกเทคนิคอื่น ๆ ที่ชวยใหผูใชสามารถโหลดเว็บเพจ             

ไดเร็วอีกดวย เชน 

7. สีพื้นหลังในเซลลของตาราง และ สีชุดแบบอักษร

ที่ตองใชเบราวเซอรในการประมวลผล ควรใชสี

เว็บ เชน #33FFCC, #FFFFFF, #FF00CC 

เนื่องจากเปนสีที่โหลดไดเร็วกวาสีที่ไมใชสีเว็บ 

เชน #6D3C16, #CDFC36 

 

 

8. หากในหนาเว็บเพจนั้น ๆ มีภาพจํานวนมาก ใหแยกหนาที่มีรูปออกมาเปนแฟมขอมูลตางหาก 

เพื่อใหปริมาณภาพในหนานั้น มีจํานวนนอยลงและใชเวลาโหลดภาพนอย 

  
 

แยกไฟลออกมา เพื่อลดจํานวนภาพในหนานั้นๆ 

 

 

 

 

 

 

      วารสารบรรณารักษศาสตร์ 25, 2 (2548) 91



 

9. หากตองใชภาพในขนาดตาง ๆ กนั ควรใชเปน

แฟมขอมูลแยกตางหาก ไมควรใหเว็บเบราวเซอร

ยอ หรือขยายภาพโดยกาํหนดขนาดความกวาง

ความสงูของภาพใหมใน Dreamweaver เพราะ

จะตองใชเวลาในการลด-ขยายขนาดภาพ และ

กรณีที่ภาพมีขนาดเล็กแตตองการขยายภาพ 

ภาพจะแตกได คุณภาพความชัดของภาพจะ

ลดลง                                                คลิกแลววินโดวใหมจะเปดขึ้นเพื่อแสดงภาพอีกภาพหนึ่ง  
                                                                                                                  ซึ่งมาจากแฟมขอมูลภาพอื่น 

 

สรุป 
 ผูเขียนไดนําเสนอการออกแบบและพัฒนาเว็บไซตตามหลักการออกแบบเว็บไซตที่มีประสิทธิภาพ 

โดยนําเว็บไซตของคณะอักษรศาสตร จุฬาลงกรณมหาวิทยาลัยเปนกรณีศึกษา การออกแบบและพัฒนา

เว็บไซต มิใชเปนเพียงการลงมือพัฒนาเว็บไซต แตตองอาศัยองคประกอบหลายประการ เพื่อใหไดเว็บไซต 

ที่ดีทั้งการออกแบบและการใชงาน ผสมผสานกับเทคนิคหลายประการ รวมถึงการจัดโครงสรางขอมูลเพือ่ให

สามารถโหลดหนาไดเร็ว การพัฒนาเว็บไซตสวนมากจะเริ่มจากการออกแบบหนาเว็บเพจดวยโปรแกรม 

Photoshop และนํามาพัฒนาเปนหนาเว็บเพจดวยโปรแกรมชวยสรางเว็บ โดยการตัดภาพที่ดีไซนไวมาเปน

หนาเว็บเพจ อยางไรก็ดี โปรแกรม Photoshop ยังใชชวยในการแตงภาพ และสรางปุม หรือภาพสําหรับ

ตกแตงเว็บเพจเพิ่มเติมดวย เว็บไซตที่ดี ควรมีเนื้อหาที่ทันสมัยและตองปรับปรุงขอมูลอยูเสมอ เว็บไซตที่

ออกแบบจึงควรตองรองรับเนื้อหาของเว็บไซตที่จะเพิ่มมากขึ้น และรองรับการปรับปรุงเว็บไซต  ในการ

พัฒนาเว็บไซตนี้ ผูเขียนใชแผนแบบ ซึ่งทําใหการปรับปรุงเว็บไซตใหทันสมัยทําไดงาย ซึ่งนับต้ังแตวันที่

ผูเขียนไดอัปโหลดเว็บไซตเพื่อเผยแพรสูอินเทอรเนต ที่ http://www.arts.chula.ac.th เมื่อวันที่                 

20 พฤษภาคม 2548 ไดมีการปรับเปลี่ยนขอมูลในเมนูยอยและสวนบริการหลายครั้ง เว็บไซตคณะ               

อักษรศาสตรที่พัฒนาสําเร็จและเผยแพร ประกอบดวยแฟมขอมูลเอชทีเอ็มแอล หรือเว็บเพจแตละหนา ทั้ง

เว็บไซตเปนจํานวน 130 แฟม  แฟมแผนแบบสําหรับแตละเมนู ทั้งแผนแบบปกติและแบบ Repeating 

Region รวม 13 แฟม ภาพที่ใชเปนเมนูและตราสัญลักษณ รวม 14 ภาพ และภาพประกอบขอมูลในเวบ็ไซต 

ที่ใช Photoshop ปรับแตง เชน ภาพกิจกรรม ภาพปกหนังสือ เปนจํานวน 780 ภาพ ใชเวลาในการพัฒนา

เว็บไซตประมาณ 200 ชั่วโมง  นับต้ังแตการศึกษาวิเคราะหขอมูลเพื่อกําหนดกลุมเปาหมายและการ

ออกแบบ การรวบรวมขอมูล  การถายภาพ จนถึงการพัฒนาเปนเว็บไซตที่มีเนื้อหาสมบูรณ ผูเขียนหวังเปน

อยางยิ่งวาบทความนี้ จะเสริมสรางเทคนิคและแนวคิดในการพัฒนาเว็บไซตที่ดีใหแกผูอานไดไมมากก็นอย 
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